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Exploring the Acrobat Interface
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Chapter 8

Acrobat is a complex application that serves the needs of several industries. You
find tools for comment and review, professional printing, legal services such as
redaction, scanning and OCR recognition, conversion methods for documents and
web pages, editing PDFs, working with interactive elements, encryption tools,
searching, spell checking, signing documents, comparing documents, exporting
content and more.

Fortunately for forms designers you don’t need to learn all the various features in
the program to create sophisticated, dynamic, and complex eForms.
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Working with Preferences

The very first thing you need to do after launching Acrobat Xl is
visit the application Preferences. You find many toggles and
switches in a long list of preferences in Acrobat. Most important
are preferences located in the General and Forms categories.

Launch Acrobat and open the preferences by pressing the CTRL
(Windows) or the Command (Mackintosh) key + K for a keyboard
shortcut. Alternately you can open the Acrobat menu (Macintosh)
and click Preferences or Edit menu (Windows) and click
Preferences.

Setting General Preferences

The Preferences window opens and you find a list on the left side
of the window with Categories listed. Click General in the left
pane and the right pane changes. Click the check box where you
see Use single-key accelerators to access tools.

Checking this box enables you to use keys on your keyboard to
access tools. It will take some time to remember all the keyboard
shortcuts but there are a few you can easily commit to memory
that help speed up your work in Acrobat. These include:

4+ Hand tool (H). After you check the item in the preferences,
individual keys you press on the keyboard select a tool.
When pressing the H key the Hand tool is selected. You use
this tool to move a document around the document pane. If

you zoom in on a form, you see only a portion of the form in
the Document pane. Click and drag the Hand tool around the
page to move the page content within the document pane.
Additionally, when you fill-in form fields, you use the Hand
tool.

4 Select Object tool (R). As the name implies, you select
objects with this tool. A field is an object. You can use the
Select Object tool to select field objects for copying/pasting,
resize field objects, manage fields by aligning and
distributing, and double-clicking a field to easily access a
field’s properties. This is perhaps the most essential tool you
find for authoring forms.

Just remembering these two tool keyboard accelerators can help
you work much faster in Acrobat when designing forms. The
remaining items in the General Preferences pane can be learned
as you become more knowledgeable about Acrobat and other
features in the program.

Setting Forms Preferences

Acrobat provides a special category in the Preferences for toggles
and switches related specifically to forms. In the left pane click
Forms and the right pane changes to reflect options you have for
setting forms preferences.

There is one item in this category that’s paramount for forms
designers and a new preference option that was introduced in
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Acrobat XI. Click Forms in the left pane and notice the item
denoted as Automatically adjust tab order when modifying fields.
You must remove the checkmark for this preference item. If you
leave this item checked, Acrobat will operate painfully slow when
working on complex forms. Always keep this item unchecked. If
you need to adjust tab orders on your forms you have many other
alternatives | discuss in Chapter 10.

Figure 8.1 Forms Preferences
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Categories: General

Commenting ™ Automatically calculate field values

Documents @cally adjust tab order when modifying fields | Manage Barcode Parameters...
Full Screen o
|_| Show focus rectangle
Ceneral
Page Display  Show text field overflow indicator
["] Always hide forms document message bar
3D & Multimedia (¥ Show field preview when creating or editing form fields
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The auto-complete feature is now off. No suggestions will be made while you type in form
fields. Choose Basic or Advanced from the drop-down box to turn the feature on.
JavaScript

Language
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Maacurina (Can) Form Tracker Preferences
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Press CTRL/Command + D. Click Forms in the left pane and remove the checkmark

The remaining items in the forms preferences are personal
choices for viewing forms and fields. You can explore these items

independently. For now, just realize the most important item to
address is turning off the auto tab order setting.

Setting Language Preferences

If your forms are assembled in a language other than US English,
you can click the Language item in the category list and choose a
language from the Application Language drop-down menu.

The remaining preferences can be left at defaults when you
installed Acrobat. As needs arise you can periodically visit the
preferences to make changes. For help with preference choices
you can open the Help menu and click Adobe Acrobat XI Pro
Help.

Adding Tool Sets

If you’re familiar with other Adobe applications you know that
most programs support creating Workspaces. A workspace is a
collection of tools and menu choices that a user personally
defines. You make choices for the contents of your workspace
and save it. You can create additional workspaces and save each
one independent of the others. If using a program like Adobe
InDesign you might create a workspace for designing print
documents and another for designing web documents. You might
use tools that support CMYK color for print and RGB color for
web and save to the respective workspace.
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In Acrobat terms, workspaces are known as Tool Sets. You
likewise determine what tools you want in a given tool set and
save the set. You can likewise create several different sets. If you
use Acrobat regularly and you work with reviewing documents
and you also design forms, you might save two different sets of
tools —one for Comment & Review and the other for Forms.

For our purposes we’re talking about forms. Therefore, you’ll want
to create a tools set that contains all the tools you use when
designing forms. To begin developing a tool set you start by
clicking the Customize button in the top right corner of the
Acrobat window to open a drop-down menu. Choose Create New
Tool Set from the menu options.

Figure 8.2 Create New Tool Set

s Slgn Com|

v €5 Default Tools

Common Tools
Forms Editing
Print Production

Find More Online...

Click Customize and choose Create New Tool Set

The Create New Tool Set window opens. Here you find a list of all
available Acrobat tools listed in the left panel, and by default you
find an empty panel on the right where you see the caption Tools
in Custom Tools pane. The right pointing arrowheads adjacent to
the tool categories in the left pane are used to expand/collapse a
category.

Figure 8.3 Add Tools to New Tool Set
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The Create New Tool Set Window
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Obviously you want to add all the items listed in the Forms box opens asking me to locate the file | want to use to
section. Click the right pointing arrow and click a tool in the list. replace the existing page or a range of pages.
To move the tool to the right pane, click the right arrow icon

. You find the Replace tool in the P t :
appearing between the two panes. Follow the same steps and oufind the Replace tool in the Pages category

add all the tools so they appear listed in the right pane. 4+ Insert from File: Also included in the Pages category is the

Other tools you’ll want to add to your Forms Editing Tool Set Insert Pages from File tool. You can use this tool to insert a

include: blank page when you want to test calculations, JavaScripts,
and button actions.
4+ Select Object tool: You find this tool located in the

Interactive Objects category. 4+ Page Templates: Page Templates are used when you want

to add new pages to a document that are spawned from

4+ Save: This is optional if you happen to know the keyboard template pages. | cover more on spawning pages from
shortcut (CTRL/Command + S) to save and update a file. templates in Chapter 18.

4+ Save As: Likewise this may be an optional choice. This You find the Page Templates tool in the Document
command is important when creating complex forms. You Processing category.

may want to save a copy of a form to test JavaScripts and

. it :
formulas without disturbing your final form. JavaScript: Open the JavaScript category and add all the

tools contained in this category.

4+ Replace: This command is used for replacing pages. | use

+ ibility: ' ' ' ’
this command virtually every time | create a new form. | find Accessibility: To comply with Section 504 in the USA you'l

: - t to add ibility to all f f A
there are many times | need to return to the original want to add accessibility to all your forms for US

document, make some edits, and convert to PDF. If | add government sites. You may need to do quite a bit of editing

field objects on a form, | want the fields to remain but | want for tagging files properly, adding alt text, and insuring that

the background design with my new changes appearing on the reading order is correct for screen readers. To add

the form. If this is the case, | choose Replace and a dialog Accessibility tools, open the Accessibility category and add

all the tools to the right pane.
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TIP

Acrobat has a Read Out Loud feature that can help you determine
reading order before forms are tested on screen readers. Choose View
» Read Out Loud » Activate Read Out Loud. Your form is read out
loud. You can control the reading speed by pressing the 0 to 9 keys on
your keyboard.

)

For creating government eForms, the above listed items are the

most important. Acrobat provides other tools that might be used
by forms designers such as distributing a form to Office 365 or a
Microsoft Sharepoint server. It’s more likely though that in
government offices you won’t use the distribution choices from
Adobe.

In the Save & Export category you find the Reader Extended PDF
tool. Since you should require all users to upgrade to Reader X,
you won’t need to enable PDFs with Reader Usage Rights. If, for
some reason, you need to support the needs of Reader users
below Reader Xl, you may want to add this tool to the right pane.

Adobe has spent much engineering time and effort in simplifying
the forms editing process and has tossed in some items such as
the Create Form tool that takes you to Adobe Forms Central
where forms can be designed from an assortment of templates.
Again this is an item not likely used by government forms
designers.

If you stick with those items recommended for adding to a Forms
Editing tool set, you have all the essential tools necessary for
designing dynamic forms.

If the order in the right pane in the Create New Tool Set window is
not the order you want, you can select items in the right pane and
click the up/down arrows to reorder the tools. When finished,
click the Save button and your new tool set is added to the
Customize drop-down menu.

Once you select a tool set, the tool set remains open in all your
Acrobat work sessions. If you want to change to another tool set,
just reopen the Customize menu and select another tool set.

Adding Tools to the Toolbar Well

Above the Document pane you find a number of tools in a toolbar
spanning the width of the Acrobat window. A few tools not loaded
by default can help when designing multi-page forms. Open a
context menu (right click anywhere on the Toolbar Well or with a
one-button mouse on the Macintosh, press Control and click to
open a context menu) and choose from the menu Page
Navigation » Previous View. Return to the same menu and
choose Next View. If you view a page such as page 1 in a
document and jump to page 5 (or another page), click the
Previous view tool to return to the page before the jump. This
saves you time over manually scrolling pages.
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If you find additional tools that work well for you, you can
examine tools in a context menu and add them to the Toolbar
Well in similar fashion.

Zooming Views

A common task when editing forms is zooming the view. You may
want to zoom in on a field to precisely size a field box, then return
to a Fit View to examine the entire form page.

You find the minus (-) and plus (+) symbols loaded in the Toolbar
Well by default. Additionally you find a text box for typing a zoom
view, a drop-down menu to choose fixed zoom views, and page
icons for Fit Window to width and enable scrolling and Fit one full
page to window. You have a number of other tools you can add
for zooming views that can be added to the Toolbar Well.

Perhaps the easiest options for zooming views is just remember a
few keyboard shortcuts. Using the shortcuts enables you to work
much faster in Acrobat. The most important for zooming views
include:

4+ Ctrl/Command + (plus): Press the Control key (Windows) or
Command key (Macintosh) and the plus (+) key to zoom the

view.

4+ Ctrl/Command - (minus): Press the Control key (Windows)
or Command key (Macintosh) and the minus (-) key to zoom
out.

4+ Ctrl/Command 0 (zero): Press the Control key (Windows) or
Command key (Macintosh) and the zero key to zoom to a
full-page view.

Try to commit these shortcuts to memory and you can quickly
zoom in and out of pages in the Document pane.

Setting Initial Views

An initial view is the zoom view when a document is opened in
Acrobat or Reader. The view can also show or hide toolbars and
show or hide panels. You can make choices for how you want
constituents to view your form when the file is opened.

The toggles you set are strictly subjective. You may want all your
forms to appear zoomed in so the form filler can clearly see the
fields on small monitors. You could also set the view to Fit Width
so the form zooms to a screen width. Another choice is to Fit
View where an entire page is shown when the file opens.
Regardless of the choice you make this item requires some
discussion in a staff meeting and some standards should be set
forth so all forms hosted by your government office are set to the
same zoom view.

Setting the opening view is handled in the Initial View window. To
access the Initial View settings, choose File » Properties or press
CTRL/Command + D. When the Document Properties window
opens, click the Initial View tab.
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Figure 8.4 Initial View Properties
Document Properties

| Description Security Fonts IGUEIRITIE Custom Advanced |

Layout and Magnification

Navigation tab: | Page Only 3

Page layout: | Single Page :]

Magnification: | Fit Page [+

Open to page: 1 of 2

Window Options
[ Resize window to initial page
| | Center window on screen

(| Open in Full Screen mode

Show: | File Name s

User Interface Options
[ Hide menu bar
[ Hide tool bars

|| Hide window controls

| Help | | cancel | [0k

Set the Initial View for forms that you want appear as the default view when the form is
opened.

When you first open the Initial View window you find a number of
drop-down menu items are set to Default. Be certain to override
all the Default choices. The Default choice pertains to Preference
choices made by individual Reader users. Some users may have
defaults set to open Fit Width, some to Fit Page, and others to
Automatic. The result is that your document is displayed

differently on different computers according to the preference
choices each user makes.

Default views would be fine if all Adobe Reader users knew they
could change a viewing preference. However, most users are not
aware of the toggles. It may be best for your department to make
the choice for what viewing option is best for most users.
Experienced users can always change the view once inside
Reader or Acrobat using keyboard shortcuts and tools.

In the Initial View window you have several choices to make that
can help the viewing experience for users. These include:

4+ Navigation tab: Typically you might set this option to Page
only. However, if you have bookmarks created for long forms,
you may want to choose Bookmarks Panel and Page from
the Navigation tab drop-down menu. You may have some
forms that are multi-lingual and the different languages may
be on separate layers in your form. If this is the case you
may want Layers Panel and Page opened when the user
views the file in Reader. Again, you make the choice in the
Navigation tab drop-down menu.

4 Page Layout: Should the form be viewed as a single page or
should continuous pages be enabled? | personally prefer
using a single page view. When viewing pages in this view,
the entire page snaps to view. When you scroll pages each
page snaps to a view in the Document pane. If you choose
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Single Page Continuous, users can scroll pages without
shapping to a full page. In essence, one can see the bottom
half of the top page and the top half of the bottom page in
the Document pane. This can be an advantage for a user if
they need to see a previous set of fields that might be helpful
in completing the next set of fields appearing on a following

page.

Page layout is another subjective judgment and warrants
discussion in a committee meeting for standardizing forms.

Magnification: This is where you set the open default zoom
view. You have several choices from the Magnification drop-
down menu. Make a choice that is the standard for your
government office.

Open to Page: By default, the number is set to 1 where the
first page in the file appears in the Document pane when a
file is opened. You may want to change this item to open
another page where a user may logically start but the form is
best viewed after populating a form from page one.

As an example, | created a health statistics form for the
Botswana Africa Ministry of Health. The form opened page
225 where a registration card for a new in-patient was
recorded. However the important part of the form was the
discharge information that resided on page 2.

Discharges occurred after the registrations. When a patient
was discharged the data from the registration card was
transposed to the patient discharge form. Data always had
to be sent from the registration card to the discharge form.
There was no way to populate registration information
manually on the discharge form. Hence, since registration
cards were always viewed first, either to add a new patient
or discharge a patient, it made sense to open the PDF on
the registration card page first —page 225.

In terms of the design for this example, | could have
designed the document with the registration cards
appearing at the beginning of the form and the discharge at
the end of the form. However, the registration cards were an
afterthought when the health professionals met and
requested additional information on the form. Extensive
JavaScripts and calculations were made that referenced
page numbers so it was much easier to modify the form by
adding registration cards at the end of the form. All of this
was transparent to the workers since pages opened
automatically when data were transposed.

4 Window Options: For eForms, all these items should be left

unchecked and at defaults.
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4+ User Interface Options: You can choose to hide items listed
in this section. You may want to avoid hiding menu bars.
Users may want to work with menu commands for saving
and closing your forms. Hiding tool bars and window
controls provides more real estate for users to work with
forms. For eForms, the tool bars and window controls may
be unnecessary for most forms. If you do choose to hide
items, be consistent for all forms your agency deploys.
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